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MeetingSense™ 3.0 
User Guide 

MeetingSense is an affordable hosted software service that empowers teams to easily 
capture, distribute and collaboratively manage meeting information and action items online in 
real time. MeetingSense has proven to eliminate hours of wasted time, save thousands in 
operational costs and dramatically decrease IT burden while providing standardized meeting 
structure that drives overall business productivity. 
 
You can get started using MeetingSense to make your meetings more productive by 
registering for a new account and downloading and installing MeetingSense Capture today. 
Follow the simple instructions below to begin. 

REGISTER FOR MEETINGSENSE 

1 Go to http://www.meetingsense.com/go/intercall.html.  
2 Complete and submit the form. 
3 MeetingSense will send you a welcome email. Log in using your temporary 

password located in the email. 
4 Fill in your name, security question and password and click OK. 
5 In Step 2, download MeetingSense Capture when prompted and then double-click 

meetingsense_capture.exe to install into your Microsoft Outlook® calendar. 

INSTALLING MEETINGSENSE CAPTURE 

1 Download MeetingSense Capture one of two ways: 
- During registration: download MeetingSense Capture in Step 2.  
- From the Home page: access your My Account link and click Download 

MeetingSense Capture. 
2 Follow the step-by-step directions given by the installation wizard. MeetingSense 

requires three dependencies to work correctly: Microsoft® .NET Framework 2.0, 
Microsoft Web Services Enhancements 3.0 and Windows Media Encoder 9. If these 
items aren’t already installed on your computer, MeetingSense will help you install 
them. 

3 Once the installer has finished, open Outlook and then schedule, start or prepare a 
meeting from the newly installed MeetingSense toolbar or right-click to view the 
menu options. 

ADDITIONAL RESOURCES TO HELP YOU GET STARTED 

Along with this MeetingSense user guide, there are a number of online resources to help you 
quickly become a MeetingSense power user. Please utilize the resources below: 

 Visit the online support center from within MeetingSense by clicking Help and 
selecting Online Support or access online support directly by visiting 
http://www.meetingsense.com/support. 
 MeetingSense contains a complete help system accessible via the Help menu and 
selecting MeetingSense Help (F1) or simply hit F1 on your keyboard. 
 A complete set of online product tutorials are available to help you become familiar 
with MeetingSense features and functionality. Just go to 
http://www.meetingsense.com/demos.  

http://www.meetingsense.com/go/intercall.html
http://www.meetingsense.com/support
http://www.meetingsense.com/demos


  

Revolutionary Meeting and Action Item Collaboration 
MeetingSense is easy-to-use meeting productivity software that lets teams capture, track and 
then collaboratively manage meeting information and action items online. Integration with 
Outlook adds instant structure and best practices to help optimize meeting scheduling and 
preparation. At meeting time, use MeetingSense Capture to efficiently record all meeting 
aspects and then instantly distribute those notes and action items via email or publish it all 
online.  

ENHANCE 

1 Enhance current meeting workflows via Outlook integration: 
 Improve current Outlook meeting scheduling. 
 Use the MeetingSense Agenda Wizard for structured meeting invitations. 
 Start every meeting utilizing industry-accepted best practices. 
 Ensure that meeting invitees come to meetings fully prepared. 

CAPTURE 

2 Capture all critical meeting information and action items: 
 Accurately record every aspect of your meetings. 
 Create contextually linked meeting record archives. 
 Ensure that action items are always captured and tracked. 
 Keep meeting minutes and other information completely organized. 

DISTRIBUTE 

3 Automatically distribute your meeting information: 
 Distribute meeting information immediately following your meetings. 
 Publish your meeting information online for instant, anytime access. 
 Email neatly stylized and easy-to-read meeting summaries. 
 Look like the consummate meeting professional at every meeting. 

MANAGE AND COLLABORATE 

4 Manage and collaborate on meetings and action items: 
 Revolutionary real-time, team meeting information and action item collaboration. 
 Shared meeting record repository with online participant access. 
 Wiki-like pre-and post-meeting collaboration with change audit trails. 
 Collaborative online team file management means reduction in IT resources. 

MeetingSense Feature Descriptions 

CHANGE MEETINGSENSE PREFERENCES TO SUIT YOUR STYLE 

Easily change preferences to customize MeetingSense to your needs. Change general 
settings, default notes font and audio recording options. 

1 Choose preferences from the File menu by clicking Tools, then Preferences. 
2 Make any changes that better suit your personal use of MeetingSense. 
3 Click Ok to have those new changes applied to MeetingSense Capture. 

 



  

SEND MEETING INVITATIONS WITH AGENDA AND CONFERENCING 
INFORMATION 

Automatically place any information that you have included in the MeetingSense Agenda tab 
of your Outlook meeting request into the body of that meeting's invitation. 
 
For new meeting requests: 

1 Click Schedule Meeting on the MeetingSense toolbar in Outlook. 
2 Enter your agenda and conferencing information and click OK. 
3 Note the agenda and conferencing information automatically copied into the body of 

your meeting request. 
4 Enter the rest of your meeting information in the meeting request and click Send to 

automatically distribute all information. 
 
For existing meetings on your calendar: 

1 Double-click the meeting on your Outlook calendar to open the meeting request. 
2 Click Agenda at the top of the meeting request. (For Outlook 2007, go to the Add-

Ins tab, then click Agenda.) 
3 Enter your agenda and conferencing information and click OK. 
4 Send the update to automatically distribute all information. 

PREPARE MEETINGSENSE MEETINGS AT ANY TIME 

Open, prepare and then save your meeting information days or even months in advance of a 
scheduled meeting. Ensure that your meeting record will open just as you want it at the time 
of your meeting. 

1 Prepare any upcoming meeting from either the MeetingSense Today screen or the 
upcoming meeting listing area. 

2 Prepared meetings will be shown in the dashboard with a green icon in the Prepared 
Meetings list on the Home page. 

CONDUCT SCHEDULED MEETING IN MEETINGSENSE CAPTURE 

Launch your Outlook meeting in MeetingSense Capture one of three ways: 
 
From the invitation: 

1 When the Outlook meeting reminder appears, double-click it to open it, then click 
Start Meeting. (For Outlook 2007, go to the Add-ins tab then click Start Meeting.) 

2 The meeting console will be loaded with information pulled from your original 
Outlook meeting invitation, including participants, any meeting files and the agenda. 

 
Context menu: 

1 Right-click any meeting on your Outlook calendar. 
2 Select Start or Prepare from the context menu. 

 
Outlook toolbar: 

1 Select any meeting on your Outlook calendar. 
2 Click Start or Prepare in the Outlook toolbar above your calendar. 

OPEN AND START CAPTURING A SPONTANEOUS QUICKMEETING 

Start a spontaneous QuickMeeting in MeetingSense Capture any time simply by clicking one 
button. 

1 From Microsoft Outlook, click QuickMeeting in your Outlook toolbar. 



  

2 Enter a meeting subject and location, then click OK to open the meeting in 
MeetingSense Capture. 

3 Use MeetingSense like normal to access the meeting record through the dashboard. 

EDIT PREVIOUS MEETINGS AND THEN SEND A NEW UPDATE OR 
SAVE AND CLOSE 

Easily edit previously prepared or conducted MeetingSense meetings using your online 
dashboard. Just find that meeting in the dashboard and click Edit. The meeting record will 
open in MeetingSense Capture exactly as it was left when the meeting ended. Then, change 
anything in the old meeting console and resend the summary or save and close the console. 

1 Select the meeting to edit in the meetings list on the Meetings page of your 
dashboard.  

2 Click Edit. 
3 MeetingSense Capture will open and load the selected meeting. 
4 Make any desired changes, then send a new update or save and close. (Note: Only 

meeting organizers will have the option to edit a meeting.) 

CUSTOMIZE YOUR MEETINGSENSE CAPTURE INTERFACE TO SUIT 
ANY MEETING 

Completely customize the MeetingSense console to fit any meeting. There are six default 
layout templates with MeetingSense, but you can drag and drop Pods around the interface, 
close or open individual Pods or resize Pods to save a new layout. 

1 Choose a default layout to start with and then open or close Pods. 
2 Move Pods by clicking, holding and dragging them around the interface. 
3 Select Layouts, then Save Layout from the File menu, then name your new layout. 

GROUP MEETINGS BY PROJECT 
Group any number of meetings or action items under a specific project listing. Project 
grouping allows multiple meetings to be linked together for easy grouping and access in 
the online dashboard. 

1 In an open meeting, use the Meeting Details button to access this functionality. 
2 Using the project area, assign this meeting to a current project from the drop-down 

or click New to create a new project for this meeting series. 

MEETING-TO-MEETING ACTION ITEM MANAGEMENT 

Easily manage open and/or overdue action items across a recurring Outlook meeting series 
or within a MeetingSense project grouping. Meeting-to-meeting action item management 
ensures all action items are completed. 

1 Assign an open meeting to a project series or Outlook recurring meeting. 
2 Open and overdue action items from past meetings will automatically appear in the 

current meeting’s Action Item Pod. 
3 Complete any closed action items. These results will be shown in the output email. 

IN-MEETING ATTENDANCE (ROLL CALL) 

Take attendance or roll call for full accountability. Roll taken during the meeting will be noted 
and sent with any output. 

1 In an open meeting, double-click or select and click Attended/Not Attended in the 
Invited Participants Pod toolbar. 

2 To change status back to the original designation, repeat this step. 



  

ACCESS PERSISTENT MEETING INFORMATION FOR RECURRING 
MEETINGS 

Display a list of the previously held meetings in MeetingSense Capture if they are part of a 
recurring meeting series in Outlook. Clicking an old meeting link will open that meeting in a 
separate tab with all of the persistent meeting data. 

1 Designate the meeting as a recurring meeting when creating it in Outlook. 
2 From the second meeting on, the Past Meetings Pod will be displayed. 
3 Click a previous meeting link and that meeting’s console will open in a tab on the 

right with all of the information exactly as you left it. 

ACCESS PUBLISHED MEETINGS AND ACTION ITEM RECORDS FOR 
ONLINE COLLABORATION ANYWHERE, ANYTIME 

The MeetingSense online dashboard gives you instant access to all prepared and captured 
meeting and action item information, including files and team collaboration, through your 
browser. 

1 Log into you online dashboard (https://ms1.meetingsense.com).  
2 Find the desired meeting on the Home page or via the Meetings tab. 
3 Find the desired action item on the Home page or via the Action Items tab. 
4 Find files in the Files tab within each individual meeting or action item record. 

USE ALERTS TO STAY UPDATED ON EVERYTHING HAPPENING IN 
YOUR MEETINGSENSE WORLD 

The MeetingSense online dashboard’s Alerts Pod is your communication center for all of the 
important actions happening as others communicate with you through MeetingSense. 

1 Log into you online dashboard (https://ms1.meetingsense.com).  
2 On the Home page, look at your alerts. (Note: Newly arrived alerts have a red X and 

are bold; already selected and read alerts will not have bold text).  
3 To access the item associated with each alert, click on the title of the item. You can 

also choose to read all or dismiss all alerts.  

SEARCH FOR ANY PIECE OF MEETING OR ACTION ITEM 
INFORMATION 

Use the search functionality to find your meetings and action items.  
1 Enter your search term in the Search box.  
2 Click Go. 
3 Click the desired search result to access the desired meeting or action item. 

USE POWERFUL ACTION ITEM FILTERING AND SORTING 

Use the powerful, intuitive action item sort and filter capability to create a custom action items 
view for any need. 

1 Log into you online dashboard (https://ms1.meetingsense.com).  
2 On the Home page (or in the Action Items tab) access the action item section with 

the filter and sort function at the top. 
3 The filter defaults to show you your open action items. 
4 To change the filter, click Filter by and choose one of the default filters, all action 

items or click Advanced Filter to build your own filter. To build your own filter, 
simply select the appropriate string of attributes. Each new attribute will be listed in 
your new filter.  

5 Click on any underlined attribute to choose another value. 
6 To sort, click the blue arrow to change the order of the listed action items or click the 

underlines attribute itself to change the value. 

https://ms1.meetingsense.com/
https://ms1.meetingsense.com/
https://ms1.meetingsense.com/


  

EASILY IDENTIFY MEETINGS BY DASHBOARD ICON 

See the specific type or state of a listed meeting by its dashboard icon. Blue icons designate 
QuickMeetings, red icons are conducted MeetingSense meetings and green icons are 
prepared meetings (located in the Prepared Meetings list on the Home page). 

1 Log into MeetingSense online dashboard. 
2 Browse the Conducted and Prepared meetings list to see the type or state of all 

meetings. 

QUICKLY FIND THE MEETING THAT YOU ARE LOOKING FOR 

The Meetings tab provides you with multiple ways to instantly find any meeting in your 
repository. You can find meetings with the interactive calendar, by day, week, month or all or 
filter meetings by project. 

1 On your Meetings tab, to find a meeting with the interactive calendar: 
- Click on a day to display that day’s meetings in the list below. 
- Use the arrows at the top corner of the calendar to navigate months. 
- Use the tabs above the list to designate day, week, month or all meetings.  

2 To filter meetings by project, select a project in the drop-down menu to show 
meetings for only that project. 

ASSIGN AN ACTION ITEM TO ANYONE FROM THE ONLINE 
DASHBOARD 

The Add Action Item button on the Meetings page gives you the ability to assign an action 
item to anyone, whether they are part of your license pack or not.  

1 Go the Action Items page and click Add Action Item. 
2 Fill in the details of the action item and click Save. (Note: The owner(s) field requires 

the full email address.) 
3 Users who are part of your license pack will receive an email and an alert. By 

clicking on the links provided in the email, they will have full access to the Action 
Item in their dashboard. 

4 Users who are not a part of your license pack will receive the Action Item, an email 
and an alert. They will also become FreeAccess Users, which gives them the ability 
to log into their Home page and view and complete the status of their action items. 

REQUEST ACTION ITEM UPDATES FROM THOSE YOU’VE ASSIGNED 

With one click, request updates from those who have not completed their assigned action 
items.  

1 On the Home page, find the action item in the Action Items pod using the desired 
filter. 

2 Click Request Update. 
3 Add a comment and send the request to the Action Item owner. 

PRINT AND EMAIL MEETING OR ACTION ITEM DETAILS IN ONE 
CLICK 

Share meeting or action item details with those who weren’t part of the original meeting using 
the MeetingSense online dashboard.  

1 In the dashboard, choose the meeting or action item you would like to share. 
2 Choose to either print the details or send them in an email. (Note: Only meeting 

organizers will have access to the Send Summary button.) 
 


